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Introduction 
 

MassChroViewer is a data viewer for liquid chromatography (LC)–mass spectrometry 

(MS) data. LC-MS data in mzXML or mzML format are visualized in two dimensions by 

retention time (RT) vs. m/z, and the peak positions extracted using data processing 

software can be overlaid. A mass ruler function to evaluate mass accuracy and adduct 

assignment, immediate color strength change to view peaks in wide intensity range, 

and MS/MS visualization tool will help assess the quality of raw and processed data. A 

database search tool linked to a mass substructure calculator is used to metabolite 

annotations. Flavonoid aglycones can be annotated using the FlavonoidSearch GUI tool. 

 

MassChroViewer is available at  

http://www.kazusa.or.jp/komics/software/MassChroViewer 

 

License 
 

MassChroViewer is available free of charge for academic purposes. The tool uses the 

following libraries: 

 

Library Website License 

Jakarta Oro 2.0.8 https://jakarta.apache.org/oro/ Apache 

License 2.0 

The Chemistry Development Kit 

(cdk-1.4.19), 

JChemPaint 

(blanch 3_2, svn revision 15623) 

https://sourceforge.net/projects/cdk/ 

http://svn.code.sf.net/p/cdk/svn/jche

mpaint/ 

LGPL 2.0 

DockingFrames 1.1.2 http://www.docking-frames.org/ LGPL 2.1 

Base64 encoder/decoder (v. 1.4) http://iharder.net/xmlizable Public domain 

 

The libraries JChemPaintMs.jar for the Fragment Calculator function and 

flavonoidsearch.jar for the FlavonoidSearch GUI tool are open source software licensed 

under the GNU Lesser General Public License, Version 2.1 (LGPL 2.1). The source codes 

of the JChemPaint are used in the library JChemPaintMs.jar with a slight modification. 
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Computer requirements 
 

A PC (64 bit, 4 GB or larger RAM is recommended) with the Java Runtime Environment 

(64 bit, version 1.7 or later) is required to run MassChroViewer. Access to the Internet is 

required to use the functions of MFSearcher, Mol Viewer, and Fragment Calculator. 

 

See the URL below for the installation of Java. 

https://www.java.com/ja/download/help/download_options.xml 

 

According to the instructions written in the section “Troubleshooting – OutOfMemory 

Error,” please set a proper memory size for Java Runtime Environment. This manual 

setting is essential in most cases, even if you use a PC with a big memory size. 

 

The software is tested in the following OS environments. 

Windows10 (64 bit), Mac OSX 10.9.5 (64 bit) and CentOS 7.2 (64 bit) 

 

Basic use 
 

Run / Exit 

 

Decompress the zip file of the MassChroViewer using decompression software such as 7 

zip. The following files are generated.  

 

 

Run on Windows 

 

Double click the file ‘MassChroViewerRun.bat’ to execute the tool. The main window of 

MassChroViewer will be displayed.  
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* A black console window as shown below will appear too. Do not close this window, or 

MassChroViewer closes too.  

 

 

Run on Mac OSX or Linux 

 

Move to the folder where the file ‘MassChroViewer.jar ’ exists. 

Execute the command below. 

 

java -Xmx2G -jar MassChroViewer.jar 

 

 

To close the tool, select ‘Exit’ in the ‘File’ menu. You can also stop the tool by clicking the 

‘x’ button at the top-right of the main window. 
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Preparation of mzXML or mzML files 

 

MassChroViewer can open mass chromatogram files in mzXML or mzML format. 

Vendor-specific binary raw data can be converted to mzXML or mzML files using 

ProteoWizard software which is available at the URL below. 

 

http://proteowizard.sourceforge.net/ 

 

* mzXML files generated by the vendor software or by the other conversion tools might 

not be opened by MassChroViewer. 

* Some mzXML files converted using ProteoWizard from raw files of some specific 

vendor machines might not be opened correctly. 

* Following bugs are observed in our Lab when raw data from ThermoFisher Scientific 

machine are converted to mzXML files. 

- Some chromatogram data might be missed when the zlib compress option is enabled. 

We recommend disabling the zlib compression option, although file sizes will increase. 

- The intensity of precursor ions in MS3 data will be output as zero in some versions of 

ProteoWizard. We recommend the use of an older version (such as 3.0.70xx). 

* In the case of Waters’ data with the lock mass calibration, raw mass values before the 

calibration might be output in the mzXML files when they are converted by an older 

version of ProteoWizard. The use of massWolf tool would avoid this issue. The massWolf 

tool is available at the following URL: 
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http://tools.proteomecenter.org/wiki/index.php?title=Software:massWolf 

 

This issue occurred with an older version of ProteoWizard, and as far as we tested, 

solved with a recent version (November 2018). We recommend checking the equivalence 

of the mzXML data to the original (lock mass-corrected) data in MassLynx to use the file 

for further analyses using MassChroViewer and other processing tools. 

 

 

Open / Close the data files 

 

Select ‘Open Mass Chromatogram Data...’ in the ‘File’ menu. Select a type of data file 

(mzXML or mzML) and select a data file to open. 

 

 

A 2D mass chromatogram (referred to as ‘2D window’) will be displayed in the desktop 

area in MassChroViewer. The full scan (MS1 scan) data are represented in the 2D 

window. The x-axis shows retention time (RT, in min.), the y-axis shows m/z values, the 

red dots show the ions detected, and the strength of the color represents the intensity of 

the ions. 

 

 

Multiple files can be opened by repeating the open file procedure. 
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To close the file, click the ‘x’ button at the top-right of each 2D window. 

 

 

Select ‘Close All’ in the ‘File’ menu to close all the 2D windows. 

 

Mouse operations for 2D window 

 

Modification Mouse operation Note 

Changing the color 

strength 

CTRL + SHIFT + wheel 

rotation 

 

Zooming in the selected 

area 

Right button click and drag  

Zooming full out Right button double click *1 

Zoom in/out Wheel rotation *1 

Moving Left button click and drag *1 

Picking up values Left button double click The RT and m/z values at 

the position will be used as 

the base of Mass Ruler and 

other link functions.  

 

*1 The direction of zooming in/out and moving can be fixed using CTRL and SHIFT 

keys. 
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- Operations with the CTRL key restricts the modifications only to the y-direction. 

- Operations with the SHIFT key restricts the modifications only to the x-direction. 

 

Users can also change the region of the 2D presentation by entering the RT and m/z 

values in the text fields at the ‘Peaks’ tab (described later).  

 

Synchronization of 2D windows 

 

The data files currently opened are listed in the ‘Data List’ tab at the right-hand side of 

the main window.  

 

 

Check the ‘Group’ checkbox to synchronize the 2D windows with the same ‘Sync.’ label. 

 

 

 

By clicking the checkbox at the top, all the data with the same ‘Sync.’ label as that of the 

active 2D window will be checked or unchecked. 
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The window size, modification of the view region, and change of the color strength are 

synchronized.  

 

To reset the color strength to default, click the ‘Reset Color Gradation’ button at the 

bottom of the ‘Data List’ tab. It facilitates synchronizing the color of the newly added 

data to the previously synchronized data. 

 

 

The absolute value of 10,000,000 is used as a default value of color strength. Ions with 

higher intensity than the value are drawn with the maximum strength. 

 

Alignment of 2D windows (for the synchronized group) 

 

Click the icon for “Align 2D Windows (Sync. Group)” on the toolbar or select ‘Align SYnc. 

Group’ in the ‘Window’ menu. The 2D windows are aligned. 
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- The target 2D windows for the alignment are the windows that have the same ‘Sync.’ 

label as the currently selected (active) window and the ‘Sync. Group’ checkboxes are 

checked. 

- The windows will be moved to places nearest to the current location.  

- The windows will not be moved if they are located nearby the border of the desktop 

area (shown in blue background) and are expected to be out of the area by the 

movement.  

 

Automatic alignment of all 2D windows 

 

By selecting ‘Align All Automatic’ in the ‘Window’ menu, all the 2D windows currently 

opened will be aligned from top left to bottom right.  
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The size of the 2D window is automatically fixed to the default value (450 x 300 pixels). 

The windows which are not be drawn in the desktop area (shown in blue background) 

will be stacked at the top left of the desktop area. 

 

Changing the view region by setting values 

 

Users can change the view region by entering RT and m/z values into the ‘Location’ or 

‘Range’ subpanels in the ‘Peaks’ tab.  

 

Location subpanel 

Enter RT and m/z values and plus/minus width for them. Click the ‘Set’ button to 

change the view region in the 2D windows.  
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m/z Shift Setting 

 

By setting the values in the ‘m/z shift’ field, a shifted view region will be represented in 

the 2D windows. This function facilitates checking the presence of shifted peaks, such 

as isotopic peaks and peaks with added/subtracted moiety to/from a target metabolite.  

 

(a) Enter a mass value for the shift in the text field at the center, and (b) select a fold 

value using the  button of the spinner at the right. 

 

 

(c) The pull-down menu at the left has preset values. By selecting the title except ‘0’, the 

preset value will be entered in the text field.  

 

The preset values are defined in the ‘massShift.ini’ file in the conf directory of the 

MassChroViewer. To customize the preset values, open the file with a text editor, write 

the title and the preset value in a line delimited by tab, and save. The preset values are 

available after a restart of the MassChroViewer tool. 

 

 

The fold value of the m/z shift can be changed by keyboard operations at the Peak Table 

(described later).  

Shift + Left cursor key Up 1 (**) 

Shift + Right cursor key Down 1 (**) 

Shift + Number key (at the top of the Set the value to the specified number 

(a) (b) 

(c) 
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keyboard, and not those of ten-key) 

Enter key Set the value to 0, and go to the next peak 

 

* For these keyboard operations, the peak list should be ‘active’ for accepting the 

operations. When the key actions are disabled, please try once to click on a peak (a row) 

in the peak table for activation.  

 

(**) Please be careful that the operations of the left or right cursor keys without pushing 

down the Shift key change the ‘Check’ and ‘Valid’ status of the peak. Details are 

described in the Peak Table section.  

 

The following keyboard operations can be used for recording the fold value in the 

comment field of the peak. This function will be useful when you record the number of 

predicted stable isotope atoms from the comparative analysis of labeled- and unlabeled- 

samples. 

Ctrl + Enter key Record the fold value in the comment field 

Ctrl + Delete key Clear the comment field 

Ctrl + Shift + / (slash) key Record a letter ‘?’ in the comment field 

 

Be careful that the previous value in the comment field will be deleted with these 

operations. 

 

 

Range subpanel 

Enter a minimum and maximum values for RT and m/z values. Click the ‘Set’ button to 

change the view region in the 2D windows.  
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Saving the view region 

 

Range List subpanel 

Click the ‘Save Current Range’ button to save temporally the view region currently 

displayed in the 2D window. The saved region will be listed in the ‘Range List’ subpanel. 

Multiple regions can be saved by repeating this operation.  

 

 

Click the ‘Set’ button on the list to display the saved region in the 2D windows. To delete 

the record from the list, click the ‘Del’ button.  

 

The saved regions will be lost when MassChroViewer is closed. 

 

 

Load and edit a peak list 

 

Users can load a peak list to MassChroViewer, and the positions of the peaks can be 

visualized in the 2D windows.  

 

The following formats are accepted: 

- The MassChroViewer format 

- The TogoMD format for peak table file 

- Tab-separated list of RT and m/z 

 

Users can export the edited results to a text file in MassChroViewer format. 

 

The File formats 
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If the file includes two-bites characters, save the file with the UTF-8 character codes. 

 

1) The MassChroViewer format 

 

It is a tab-separated text file. 

The first row is a header that starts with ‘No.’ (mandatory). 

The subsequent rows are the data body as follows: 

Column Description Value 

1: No. Peak identifier String (mandatory. redundant identifiers 

are not allowed) 

2: Cmnt Comments String 

3: RT Retention time (min) Numerical (mandatory) 

4: mass m/z value Numerical (mandatory) 

5: Int. Intensity Numerical (mandatory) 

6: Check Check status TRUE or FALSE (mandatory) 

7: Adct Adduct String 

8: Valid Valid status TRUE or FALSE (mandatory) 

 

An example of the file opened by Microsoft Excel is as follows: 

 

 

2) The TogoMD format for peak table file 
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This is a tab-separated text file (Ara et al., 2015). See the following URL for the details: 

(http://metabolonote.kazusa.or.jp/TogoMetabolomeDataFormat). 

 

The first two rows start with ‘#’ are ignored when importing into MassChroViewer.  

The third row starts with ‘id’ is the header. 

The subsequent rows are the data body in the following format. 

Column Description Value Imported into 

MassChroViewer 

1: id Peak identifier with 

‘P’ plus numbers 

String Yes (mandatory, 

redundant identifiers 

are not allowed) 

2: intensity Intensity Numerical Yes (mandatory) 

3: retention_time Retention time (min) Numerical Yes (mandatory) 

4: retention_index Retention index Numerical  

5: mass_detected m/z value Numerical Yes (mandatory) 

6: ion_species Adduct String Yes 

7: isotope_peaks Information on stable 

isotopic peaks 

String  

8: annotation Annotation String Yes (imported to the 

‘Comment’ field) 

9: annotated_method_ 

details_id 

ID for annotation 

procedures with ‘AM’ 

plus numbers 

String  

10: annotated_ 

compound_id 

IDs for the annotated 

compound 

String  

11: comment Comment String  

 

An example of the file opened by Microsoft Excel is as follows: 
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3) Tab-separated list of RT and m/z 

 

This is a tab-separated text file where a pair of RT (min) and m/z values separated by a 

tab is written in each row. The rows that start with ‘#’ are ignored.  

 

An example of the file opened by Microsoft Excel is as follows: 

 

 

Opening the peak file 

 

Select ‘Open Peak File’ in the ‘File’ menu. Select a peak file to open. The file format is 

automatically judged. 
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The loaded peaks are shown in the peak table at the ‘Peaks’ tab. The file name is shown 

in the ‘Peak File’ field.  

 

 

 

Saving the peak file 

 

Select ‘Save Peak File’ in the ‘File’ menu when peaks are displayed in the peak table. 

Select the file name to save and press the ‘Save’ button. The peaks are saved in a text 

file in the MassChroViewer format. 
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Save and load the project 

 

Information about currently analyzed mass chromatogram files, a peak file, and the 

locations of the 2D windows can be saved in a project file. The analysis environment can 

be easily reconstructed by loading the project file.  

 

Saving the project file 

 

Select ‘Save Project…’ in the ‘File’ menu.  

 

 

Select a project file to save, and then click the ‘Save’ button. 

 

The paths to the mass chromatogram files currently opened, settings for the 

synchronizing view of them, the locations of the 2D window, and the path to the peak 

list file are saved in the project file. 

 

Loading the project file 

 

Select ‘Open Project…’ in the ‘File’ menu. Select a project file, and click the ‘Open’ 

button. 
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A dialog window that confirms disposal of the information for currently analyzing files 

will be displayed. Click ‘Yes’ to continue. 

 

 

The progress of the file loading will be displayed in a window. 

 

The progress window closes when the loading is finished. 

 

 

 

Operation and Editing of the peak table 
 

The comments, types of adducts and check/valid status (described later) of the peaks 

can be edited. New peaks can be added and some peaks can be deleted. The edited 

results can be saved in a text file according to the procedure described in the ‘Saving the 
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peak file’ section.  

 

The 2D view around the selected peak 

 

Select a peak by clicking a row in the peak table. The region around the peak position is 

displayed in the 2D windows. The margin of the RT and m/z specified in the ‘Location’ 

subpanel are used to set the region. 

 

 

Changing the fold value of the m/z shift 

 

The fold value of the m/z shift can be changed by keyboard operations when a peak is 

selected.  

Shift + Left cursor key Up 1 (**) 

Shift + Right cursor key Down 1 (**) 

Shift + Number key (at the top of the 

keyboard, and not those of ten-key) 

Set the value to the specified number 

Enter key Set the value to 0, and go to the next peak 

 

* For these keyboard operations, the peak list should be ‘active’ for accepting the 

operations. When the key actions are disabled, please try once to click on a peak (a row) 

in the peak table for activation.  

 

(**) Please be careful that the operations of the left or right cursor keys without pushing 

down the Shift key change the ‘Check’ and ‘Valid’ status of the peak. Details are 

described in the next section.  
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Editing Check and Valid status 

 

Users can attach some tags to the peaks: two marker tags of Checked and Valid status, 

and one string tag as Comment. Users can use these tags for arbitral meaning for their 

purpose. For example, the Checked and Valid status can be used like the following 

general meaning. 

 

Checked: The peaks that have been checked manually 

Valid: The true positive peaks 

 

The Checked and Valid status can be changed by clicking the checkboxes in the ‘Check’ 

and ‘Valid’ columns in the peak table.  

 

 

There are other operations to change the status as follows: 

 Change of the Checked state Change of the Valid state 

On the peak table Click the checkbox in the ‘Check’ 

column 

Click the checkbox in the ‘Valid’ 

column 

Keyboard Press the ‘C’ key Press the ‘V’ key 

Cursor key Press the ‘left’ key Press the ‘right’ key 

 

The numbers of the Checked and Valid peaks are displayed below the peak table.  
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Visualization of the peak positions in the 2D window 

 

By checking the checkboxes at the bottom of the ‘Peaks’ tab, the positions of the peaks 

can be visualized as markers in the 2D windows according to their Checked and Valid 

status.  

 

 

The markers represent as follows: 

Selected  The peak selected in the peak table 

Checked  The peaks with Checked status 

* Drawn before the Valid status 
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Rest  The peaks without Checked status 

Valid  The peaks with Valid status 

* Drawn before the Rest 

 

 

Picking a peak from the 2D window 

 

Click on the 2D window. The nearest peak at the clicked position is highlighted in the 

peak table. 

 

* The peaks without Valid status cannot be selected by this operation for the 

specifications of MassChroViewer.  

 

Editing the comments 

 

The comment attached to the peak is displayed in the ‘Comment’ field. To update the 

comment, edit the ‘Comment’ field and press the ‘Return’ key or click the ‘Save’ button. 

 

 

The following keyboard operations can be used for recording the fold value of the m/z 

shift immediately. This function will be useful when you record the number of predicted 
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stable isotope atoms from the comparative analysis of labeled- and unlabeled- samples. 

Ctrl + Enter key Record the fold value in the comment field 

Ctrl + Delete key Clear the comment field 

Ctrl + Shift + / (slash) key Record a letter ‘?’ in the comment field 

 

Be careful that the previous value in the comment field will be deleted with these 

operations. 

 

Editing the adduct ion 

 

The type of adduct ion of the selected peak is displayed in the selection list at the bottom 

of the peak table. All adducts used in the peak table are shown in the selection list. To 

change the adduct ion, select another one from the list or enter a new adduct ion and 

click the ‘Set Adduct’ button. 

 

 

 

Add/Remove peaks 

 

When double-clicking in the 2D window, the RT and m/z values at the clicked position 

are displayed in the ‘Current m/z’ and ‘RT’ fields at the bottom of the peak table. Click 

the ‘Add Peak’ button to add a peak of this position to the peak table. The ID of the 

added peak will be automatically assigned to as one ‘Add’ plus an incremental number. 

The intensity, adduct ion, Checked status, and Valid status will be zero, blank, 

unchecked, and checked, respectively.  
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To remove the selected peak, click ‘Del Peak’ button. 

 

 

Other operations for the peak table  

 

Sorting the table 

 

The rows are sorted according to the values by clicking the table header. The sort 

direction will be changed by the number of clicks as follows: 

First click: Ascending (marked with ) 

Second click: Descending (marked with ) 

Third click: Return to the original order (not marked)  

 

 

Search peaks 

 

Input a query string in the ‘Search’ field to search peaks. 
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The peaks that match one of the following conditions will be shown in the peak table. 

- The value in ‘No.’ column starts with the query string 

- The value in ‘Cmnt’ column includes the query string 

- The value in ‘RT’ column starts with the query string 

- The value in ‘mass’ column starts with the query string 

 

Press the ‘Escape’ key or empty the ‘Search’ field to cancel the search and to show all 

peaks. 

 

Memorize the peaks 

 

Users can memorize the peaks temporally. Click the ‘Memory’ button to memorize the 

selected peak. The peak ID, RT, and m/z will be added to the selection list. 

 

 

To jump to the memorized peak, select the peak from the selection list and click the ‘Go’ 

button. 

The memorized information will be lost when MassChroViewer is closed. 

 

 

Quick change of the m/z width 

 

 

The m/z width of the view region in the 2D window can be quickly changed to one of the 
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preset values. Select a value from the ‘m/z range preset’ selection list and click the ‘Set’ 

button. The values in the ‘Location’ subpanel will be changed too. 

 

 

 

Mass Ruler settings 
 

MassChroViewer provides a powerful function, ‘Mass Ruler ’, to show the differences 

between the m/z values of the peaks drawn in the 2D window. Users can customize the 

ruler settings. 

 

On/Off of the Mass Ruler 

 

Select ‘Mass Ruler Setting’ in the ‘Setting’ menu to open the setting window. 

 

 

Check/uncheck the ‘Show ruler’ checkbox to show/hide all rulers on the 2D window. This 

  

  

or 
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can be operated by the toggle button on the toolbar. 

 

 

Some sets of rulers are provided by defaults. Check/uncheck the checkboxes in the 

‘Show’ column to show/hide the rulers.  

 

Customization of the ruler 

 

The ruler settings are written in the ‘ruler.ini’ file in the ‘conf ’ folder of the distributed 

file set of MassChroViewer. Users can customize the ruler settings by editing the 

ruler.ini file. A setting guide is included in the ruler.ini file. To update the settings 

immediately, click the ‘Reload’ button in the Mass Ruler Setting window after saving the 

ruler.ini file. 

or 

  
on 

off 
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The name of some ruler items designated by a comment ‘don’t change this name’ cannot 

be changed because special internal calculations for the mass values of the indicator are 

required according to the adduct ions and m/z shift values assigned to the peak.  

 

 

 

 

MS2Viewer 
 

MassChroViewer has a powerful tool named ‘MS2Viewer’ which can visualize the 

positions of the precursor ions for MS/MS (MSn) analyses on the 2D View panel. The 

MSn spectra can be seen in the MSn View panel. MS2Viewer cooperated with 

MassChroViewer helps users checking the MSn analysis conditions and the quality of 

MSn spectra. The tool can also be used for annotating the MSn fragments and 

metabolites. 
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Run MS2Viewer 

 

Open at least one data file by MassChroViewer. Click the ‘Open by MS2Viewer ’ button 

at the bottom of the ‘Data List’ tab. The currently selected data file will be opened with 

MS2Viewer. Users can recognize the currently selected data file by the active status of 

the 2D window or the selection status of the radio button on the ‘Data List’ (see the 

areas rounded by green lines in the figure below). 
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* It takes several seconds to reload the entire MSn data from the mass chromatogram 

file. 

 

 

Another way to run 

 

Select ‘MS2Viewer’ in the ‘Tool’ menu when MS2Viewer has not run yet, then 

MS2Viewer runs without loading data. Select ‘Open Mass Chromatogram Data ...’ from 

the ‘File’ menu of MS2Viewer and select a mass chromatogram file in mzXML or mzML 

format to load the data.  
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Basic use of MS2Viewer 

 

Mouse operations in 2D View 

 

The mouse operations such as zoom in/out, moving, color strength changing, and so on 

are the same as those of the MassChroViewer 2D window.  

 

Displaying the positions of the precursor ions 

 

Check the checkbox next to ‘Show Prec.’ at the bottom of the 2D View panel. The 

positions of the precursor ions for MS/MS (MS2) scan are represented as blue markers. 

 

 

Selection of the precursor ion 

 

  

s 
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Click on the 2D View panel, then the nearest precursor ion to the clicked position is 

highlighted in the table at the Control Panel. Select the highlighted row in the table, 

then the exact position of the precursor ion is represented as a large green marker on 

the 2D View. The MSn spectrum will be displayed on the ‘MSn View’ panel. 

 

 

Levels of MSn analyses are shown at the ‘MSn’ column of the table. The information of 

the product scans is displayed just under the row of the precursor scan. 

 

 

The columns ‘Prc No.’ and ‘Prd No.’ show the scan number of the precursor scan and 

product scan, respectively. In the figure above, for example, the MS3 scans of the 

numbers 7764 and 7765 are the product scans for the ions of m/z 271.08 and 433.11, 

respectively, detected in the MS2 scan of the number 7759.  

 

Browsing the MSn spectra 

 

The ‘MSn View’ panel shows the information of MSn spectra of the selected scan.  
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In the spectrum panel, the orange line shows the m/z of the precursor ion. In the ion list 

at the right-hand side, the column ‘NL’ shows the neutral loss value (the mass difference 

between the fragment ion and the precursor ion). ‘Rel Int.’ shows the relative ion 

intensity to the maximum intensity (scaled to 1000) in the spectrum. 

 

Click one of the ions in the spectrum panel, then the nearest ion to the clicked position 

is highlighted in blue. By moving the mouse cursor, the nearest ion to the cursor 

position is highlighted with a red square, and the following information will be 

displayed: the mass value, the relative intensity, and the mass difference between the 

highlighted peak.  

 

 

To change the number of decimal places of the mass values in the table, enter a number 

in the ‘Decimal’ field and click the ‘Return’ key. 
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Copy/Export the spectral data 

 

 

Users can copy or export the spectral data as several text formats to the clipboard or a 

file by clicking the ‘Copy / Expt’ button.  

 

The action (copy to the clipboard or export to a file) and the type of formats are set by 

clicking the button of  icon.  

 

 

Format 

 

Tab-separated: 
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The m/z value and the intensity are separated by a tab in each row. This format is 

acceptable for the spectrum search functions at websites such as METLIN 

(https://metlin.scripps.edu/) and HMDB (http://www.hmdb.ca/). 

 

Space-separated: 

This format is acceptable at the spectrum search function in MassBank 

(http://www.massbank.jp/). 

 

* When the checkbox ‘Add precursor info’ is checked and the ‘Tab-separated’ and 

‘Space-separated’ are selected, the mass value of the precursor ion is attached at the 

head of the text. 

 

MAGMa: 

This format is used for Mass Tree search on the MAGMa website 

(http://www.emetabolomics.org/magma). All the information of product scans after the 

selected scan will be exported in the text. All the information of product scans after the 

selected scan will be exported in the text.  

 

MS-FINDER (.maf): 

This format is used for search by MS-FINDER software 

(http://prime.psc.riken.jp/Metabolomics_Software/MS-FINDER/). The following optional 

setting is required. 

 

- The name for the ‘NAME:’ item. ‘Scan ID’ or ‘Peak ID’ is selectable. 

- The adduct ion type for ‘PREC TYPE:’ item. A default value ([M+H]+ or [M-H]- for 

positive or negative mode), arbitral value (Specified), or the value written in the Peak 

List (Assigned) is selectable. 

 

Target 

 

Clipboard: 

The text will be copied to the clipboard. 

 

File: 

The text will be exported to a file. Select a folder by clicking the ‘Select’ button. The file 

name will be assigned based on the ‘Scan ID’ or ‘Peak ID.’ 
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Linkage to MassChroViewer 

 

MS2Viewer cooperates with MassChroViewer when the ‘Link MCV’ checkbox at the 

bottom-right of the ‘2D View’ panel is checked. 

* The auto-data loading by the ‘Open by MS2Viewer ’ button mentioned above is 

disabled if the Link MCV is unchecked.  

 

 

By double-clicking the 2D window or selecting a peak from the peak table in 

MassChroViewer, the same view region is displayed in the 2D View panel of MS2Viewer. 
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Searching precursors with specified MSn fragments 

 

By using the ‘Select Fragment’ control panel, the positions of the precursor ions whose 

spectra include fragment ions matched to specified conditions will be highlighted with 

small green markers in 2D View.  

 

 

The following parameters can be set: 

mass The target m/z value. When the checkbox next to ‘is NL’ is checked, the 

neutral loss values are searched.  

margin The mass tolerance given in daltons (Da). When the checkbox next to ‘is 

ppm’ is checked, ppm is used as a unit instead of Da.  

MS level The level of the MSn scans. Only the scans with the specified level are 
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searched. 

top order Only top N ions ordered by their intensity are searched. Specify N in the ‘top 

order’ field. 

top ratio Ions whose ratio of the intensity to the highest ion intensity in the spectra 

are more than the specified value (0–1) are searched. 

 

Set the parameters and click the ‘Select’ button to search. 

Even if more than three is set for the ‘MS level’, the position of the precursor ion in the 

MS1 scan of the MSn tree is always represented in the 2D View panel. 

 

Other functions 

 

Visualization of ion intensities 

 

There is a panel that shows the intensities of the ions at the right-hand side of the 2D 

View panel. The intensity of the ions in the MS1 scan at the clicked position in 2D View 

(gray line) is displayed. 

 

 

Click the ion in the intensity panel, then the nearest ion to the clicked position is 

highlighted in blue. Move the mouse cursor, then the information of the nearest ion to 

the cursor position (m/z value and relative intensity to the highlighted ion) is displayed. 

This function is helpful such as checking the existence of the stable isotope peaks and 

their intensity ratio to the monoisotopic peak. 
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Setting the view region by values 

 

Enter the RT and m/z values and their widths in the input fields at the bottom of the 2D 

View panel. Press the ‘Return’ key to change the view region in the 2D View. The units 

for RT and m/z are minutes and Da, respectively. The input fields for RT and m/z are 

independent. Therefore, please press the ‘Return’ key in both RT and m/z fields if you 

would like to set both RT and m/z. 

 

 

 

Other settings 

 

For reducing memory use, some settings for loading and displaying data are enabled by 

defaults in MS2Viewer. Users can change the settings. 
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Data load settings 

 

Select ‘Data Load Setting’ at the ‘Setting’ menu. 

 

The following items can be changed: 

Load signal cutoff:  

MS1 (absolute value): This setting is for MS1 scans. Only the ions with higher 

intensity than the specified absolute value are loaded. 

MS2- (relative to base peak): This setting is for scans further than level 2. If the ratio of 

the ion intensity to the maximum intensity in the scan is higher than the specified 

value (0–1), the ion is loaded. 

Margin to find precursor: The mass tolerance to find the precursor ions. There are cases 

depending on the MS vendor that the mass value of the precursor for the product scan 

written in the mass chromatogram file (mzXML or mzML) is far different from those of 

the ions in the precursor scan. Please set this parameter value according to the mass 

chromatogram data. In the MS2Viewer, both ions of highest intensity and nearest mass 

value in the mass tolerance will be recognized as precursors. If the above two candidates 

are different ions, both of them are displayed in the precursor table. Furthermore, it 

might happen when a large mass tolerance is set that the same precursor ion is 

associated with the different MSn scans.  

 

Click the ‘Set and Reload Data’ button to refresh the data.  

 

 

Draw settings for 2D View 

 

Select ‘Other Setting’ in the ‘Setting’ menu. 
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The following parameters for 2D drawing are set: 

Draw cutoff (0~1) If the ratio of the ion intensity to the highest ion intensity in the 

view region is higher than the specified ratio, the ion is drawn on 

the panel. The peaks with lower intensities can be recognized by 

strengthening the color intensity. 

Draw wait (mills) Set a brief wait time as milliseconds to redraw the panel. A 

slowness of redrawing might happen when a wider view region is 

displayed in larger window size, and mouse operations such as 

color strength change are done. In these cases, the slowness will 

be improved to set a brief wait time (~30 mills). On the other 

hand, when viewing a small region, quick responses to the mouse 

operation will be expected with no wait time.  

 

Click the ‘Set’ button to update the setting.  

 

Mass Ruler Setting 

 

Select ‘Mass Ruler Setting’ in the ‘Setting’ menu. The operations are the same as those 

of MassChroViewer. The same ruler.ini file is used in both MS2Viewer and 

MassChroViewer. 

 

Changing the layout of the windows 

 

The main window of MS2Viewer is constructed by several sub-windows with the 

following icons at the top-right corner.  
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The window layout can be changed by dragging the sub-windows outside of the main 

window, dragging them into another sub-window, clicking these icons, and so on. 

 

 

 

Other tools 
 

Formula Calculator 

 

This is a simple tool for calculating theoretical mass values of given formula and their 

adducts, checking the ratio of stable isotopes, predicting the formulae from mass values, 

and so on.  

 

Select ‘Formula Calculator’ from the ‘Tool’ menu. 

 

 

 

Mass value calculation from formula (Mass Calc) 

 

or 
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Enter a formula in the ‘Formula’ field and select an Adduct type. The theoretical mass 

values for the formula and its adduct and the mass differences between them are 

displayed. When the letter ‘e’ is entered in lower case, the accurate mass value of the 

electron is displayed.  

 

 

* The information of the adducts is written in the ‘adduct.ini’ file in the ‘conf ’ folder of 

the MassChroViewer distribution file set. This setting is shared by all the tools in 

MassChroViewer. See the section ‘Other settings - Format of the adduct.ini file’ for the 

details of the adduct.ini file. 

 

Clean up the formula 

 

Click the ‘Clean’ button to clean up the text entered in the ‘Formula’ field. The 

redundant atoms written in the filed are compiled in a non-redundant manner. This 

function can be used to simplify the formulae with such as some bound waters and some 

variation of substituents.  

 

 

Checking the accurate mass and ratio of stable isotopes 

 

Enter an element symbol in the ‘Atom’ field to show the information of the varieties of 

the stable isotopes of the atom. The theoretical weight (Weight), relative isotopic 

abundance (Ratio), mass differences from the most abundant isotope (Dif.Mass) are 
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displayed. 

 

 

The mass values and the relative abundances are based on the IUPAC technical report 

by De Leater JR et al. (de Laeter et al., 2003). The information is shared by all tools in 

MassChroViewer. 

 

Batch calculation of the accurate mass (Batch) 

 

This function is used for calculating mass values for a large number of formulae. Enter 

the formulae in the text area separating by newlines, and click the ‘Calc Now’ button. 

The theoretical mass values of the formulae and their adduct selected by the ‘Adduct’ 

list in the ‘Mass Calc’ tab are displayed as tab-delimited text in the same text area.  

 

 

Calculation of formulae from a mass value (Find Formula) 

 

This function calculates possible formulae using a given mass value in the ‘Mass’ field, a 

mass tolerance (ppm) in the ‘margin’ field, and the kind and the maximum number of 

atoms as the ‘Atoms’ field. The type of adduct and charged state can be considered, and 
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the resulting mass values used for the calculation are displayed in the ‘Mass Calc’ field. 

When the checkbox next to ‘Filter’ is checked, only the formulae that match the Senior 

and Lewis valence rules are displayed. The results are displayed in a tab-delimited text 

in the text area. 

 

 

The types and the maximum number of atoms in the ‘Atoms’ field are given as a string 

where pairs of element symbols and numbers are concatenated without spaces.  

 

 

MFSearcher GUI 

 

MFSearcher (Sakurai et al., 2013; Sakurai et al., 2018) is a tool to search the 

compounds matched to the given mass value rapidly. The major compound databases, 

KEGG (Kanehisa et al., 2016), KNApSAcK (Afendi et al., 2012), HMDB (Wishart et al., 

2013), a flavonoid database in metabolomics.jp 

(http://metabolomics.jp/wiki/Category:FL, referred as to Flavonoid Viewer), LIPID 

MAPS (Fahy et al., 2009), PubChem (Wang et al., 2009) can be searched. The tool can 

also rapidly predict the possible elemental formulae and linear polypeptides (up to MW 

1000) matched to the given mass value.  

 

Enter a mass value in the ‘mass’ field and mass tolerance in the ‘margin’ field. Select the 

type of adduct from the ‘adduct’ list and check the databases. Click the ‘Search’ button, 

and then the results are listed in the table. The detailed information on the original 
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website for the compound in the selected row will be displayed in a web browser by 

clicking the ‘Link’ button. 

 

 

The tool can also search a unique database named ‘UC2’. One of the issues in a database 

search-based annotation of the metabolites is that the false positives occurred by the 

varieties of registered states such as follows: neutral, charged, and complex of multiple 

components (e.g., salts). Furthermore, the same compounds are registered in different 

databases, which humpers the immediate recognition of the isomers from the same 

compounds. The Unique Connectivity of Uncharged compound database (UC2) solves 

these issues by storing the compounds as neutralized form by adding/removing the 

hydrogens to/from the formula based on the signature of the unique connectivity of the 

atoms using the first block (14 letters) of the InChIKey. 

 

Check the ‘UC2’ radio button, set the other conditions, and click the ‘Search’ button. The 

compounds that have the same connectivity of the atoms are compiled in a record in the 

result table. By selecting a row, the compounds included in the result are shown at the 

table on the right-hand side. Click the compound and click the ‘Link’ button to show the 

details on the original website. 
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In the UC2 search mode, users can also search the UNPD database (Gu et al., 2013). 

Prediction of formulae and searching linear peptides are disabled in the UC2 mode. 

 

The detailed manual of the MFSearcher GUI tool is available at the MFSearcher 

website (http://webs2.kazusa.or.jp/mfsearcher/). 

 

 

Cooperation with the other tools 

 

When double-clicking the 2D window and selecting a peak from the peak table of 

MassChroViewer, the mass values are automatically entered in the ‘mass’ field of the 

MFSearcher tool. An immediate search can be performed for the selected peak. 

 

When the Mol Viewer tool and the Fragment Calculator tools are active, the chemical 

structure of the compound is displayed on these tools by selecting a compound from the 

search result tables.  

 

Mol Viewer 

 

Users can check the chemical structures of compounds searched by MFSearcher. 

 

Select ‘Mol Viewer’ in the ‘Tool’ menu to open the Mol Viewer window. 
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When the Mol Viewer window is displayed, select a row in the search result of 

MFSearcher. The chemical structure of the selected compound is displayed in the Mol 

Viewer window. 

 

* The information of the chemical structure as MDL Mol or MDL SDF format is 

acquired from the original website via the Internet. Depending on the LAN 

environment, it may take several seconds to show the structure. Some structural 

information may not be retrieved from the original websites due to such as the 

specification of the database and the difference of the version of the records.  

 

In the UC2 search mode, select the compound from the table at the right-hand side.  

 

 

Fragment Calculator 

 

This tool provides a function to calculate the mass values of selected and unselected 

or 
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substructures in the molecule. It helps users annotate the MSn fragments and then the 

metabolites by checking the neutral loss information represented in MS2Viewer.  

 

Select ‘Fragment Calculator ’ in the ‘Tool’ menu. 

 

 

When selecting a compound from the MFSearcher results, the structure is displayed in 

the Fragment Calculator window. 

 

 

Click on an icon for a rectangle or a lasso selection tool at the toolbar. 

 

 

Select the atoms by mouse button dragging. The selected atoms and bonds are 

highlighted in blue. The masses and formulae of the selected and unselected atoms are 

displayed at the bottom of the window.  

or 
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* The chemical structure can be zoomed in/out by rotating the mouse wheel. 

 

Drag the selected atom(s) to modify their draw position. This function helps to select the 

atoms in a complex structure.  

 

 

The ‘Get from web’ button is used to retrieve a Mol formatted file from websites such as 

HMDB. Enter the URL of the mol data, and click the button.  
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FlavonoidSearch GUI Tool 

 

FlavonoidSearch is a system for annotating flavonoid aglycones using MS spectrum 

data (Akimoto et al., 2017). An MS spectrum browsing on the MS2Viewer can be 

immediately searched using a link function to a FlavonoidSearch GUI tool. 

 

Select ‘FlavonoidSearch Tool’ in the Select ‘Fragment Calculator ’ in the ‘Tool’ menu. 

 

The main window of the FlavonoidSearch GUI tool is displayed. 

  

or 
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Click the ‘FS’ button at the bottom-right of the MSn View panel of the MS2Viewer tool. 

 

 

MS spectrum data are automatically loaded in the FlavonoidSearch tool, and searched 

results are displayed. 
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The candidates of flavonoid aglycones are shown in the bottom table. 

 

For the details of the FlavonoidSearch GUI tool, see the manual of the tool available at 

the FlavonoidSearch website 

(http://www.kazusa.or.jp/komics/software/FlavonoidSearch). 

 

Check Indicator 

 

The checking status of Checked and Valid for the selected peaks can be visualized in a 

large indicator. This tool, with the combination of on/off shortcuts by keyboard, 

facilitates a rapid manual checking of the peaks. 

 

Select ‘Check Indicator’ from the ‘Tool’ menu to display the indicator. Select a peak from 

the peak table, and then the Checked and Valid status is displayed by red and green 

rectangles, respectively. If Checked and Valid are unchecked, the rectangles are drawn 

by gray.  

 

 

To disable the color representation, uncheck the ‘Check’ and ‘Valid’ checkboxes on the 

indicator. The rectangles are always drawn in gray. 

 

 

Other settings 
 

or 
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Settings for data loading and drawing 

 

These are the settings for saving memory use and for lighter behavior of the tool. Ions 

with lower intensity can be omitted from data loading and 2D drawing.  

 

Select ‘Other Setting’ in the ‘Setting’ menu. 

 

 

Data Loading: Setting for data loading. 

Load signal cutoff: Only the ions with intensity higher than the specified value are 

loaded from the mass chromatogram data file (mzXML or mzML). This setting will save 

memory use, but on the other hand, it will become difficult to recognize background 

noises and weak peaks. 

 

2D View Drawing: Settings for the data drawing on the 2D window.  

Draw cutoff (0~1): If the ratio of ion intensity to the highest ion intensity in the view 

region is higher than the specified ratio (0-1), the ion is drawn on the 2D window. The 

peaks with lower intensities can be recognized by strengthening the color intensity.  

Draw wait (mills): Set a brief wait time as milliseconds to redraw the panel. A slowness 

of redrawing might happen when a wider view region is displayed in larger window size 

and mouse operations such as color strength changing are performed. In these cases, 

  

or 
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the slowness will be improved by setting a brief wait time (~30 mills). On the other hand, 

when viewing a small region for many data files, quick responses to the mouse 

operation will be expected with no wait time. 

 

Presentation of the Tools: When it is checked, Formula Calculator, MFSearcher and Mol 

Viewer are displayed in the main window of MassChroViewer as similar to the 2D 

windows. This option contributes to reducing the icons on the taskbar.  

 

Click the ‘Set’ button to update the setting.  

 

 

Format of the adduct.ini file 

 

The format of the adduct.ini file is a tab-delimited text as follows. 

 

 

Column No. Description 

1  Display title 

2 Number of ‘M’ (e.g., enter 2 for [2M+H]+) 

3  Formula added 

4  Formula subtracted 

5  Optional mass value 
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6  Charge 

7  Not used in MassChroViewer 

 

Edit and overwrite the adducti.ini file, and restart MassChroViewer to enable the 

modification. The setting of the adduct.ini file is shared by all tools in MassChroViewer.  

 

 

Advanced use 
 

Standalone execution of each tool 

 

By adding options to the execution command, Formula Calculator, MFSearcher, and 

MS2Viewer can be executed as standalone software. 

 

Formula Calculator java -Xmx2G -jar MassChroViewer.jar --formulacalculator 

MFSearcher java -Xmx2G -jar MassChroViewer.jar --mfsearcher 

MS2Viewer java -Xmx2G -jar MassChroViewer.jar --ms2viewer 

 

 

 

Trouble shootings 
 

OutOfMemory Error 

 

Despite the abundant RAM on the PC, a message of ‘OutOfMemory’ error might be 

displayed on the black console window. This issue can be avoided by a modification of 

the execution command of MassChroViewer.  

 

Open the execution file ‘MassChroViewerRun.bat’ using a text editor such as Notepad. 

 

In the execution command, the part ‘2G’ in the ‘-Xmx2G’ option specifies the maximum 

memory that can be used by MassChroViewer. Please specify a larger memory size 
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according to the PC environment. For example, -Xmx8G can be set when your PC has 

12GB of memory and other software is not used. You will be able to open a larger 

number of data files.  

 

Ex) java -Xmx8G -jar MassChroViewer.jar  

 

* A decimal point cannot be included in the option. If necessary, specify the memory size 

by MB as like ‘-Xmx2500M’ 

* If you use 32 bit PC or 32-bit version of Java, the maximum size will be around 

1300MB. 

 

Overwrite the execution file, then restart MassChroViewer. 

 

The memory use of MassChroViewer can be monitored at the status bar of the main 

window.  

 

 

 

Publications 
 

Sakurai N and Shibata (2017) Tools and databases for an integrated metabolite 

annotation environment for liquid chromatography-mass spectrometry-based 

untargeted metabolomics. Carotenoid Science 22: 16-22 

 

 

Contact information 
 

Nozomu Sakurai 

E-mail: sakurai AT nig.ac.jp (replace AT with @) 
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Kazusa DNA Research Institute, Chiba 292-0818, Japan 
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